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Introduction
The SQL Server® Reporting Services Guide describes how to install and configure 
Microsoft® SQL Server Reporting Services, how to deploy predefined reports that 
are included in Microsoft Dynamics GP to a server or to a Microsoft SharePoint® 
reports library using the Reporting Tools Setup window, and how to set up security 
for reports.

Review the following table for the version of SQL Server Reporting Services and the 
report type available for that version.

This introduction is divided into the following sections:

• Symbols and conventions
• Contacting Microsoft Dynamics GP Technical Support
• Send us your documentation comments

Symbols and conventions

This documentation uses the following symbols and conventions to make specific 
types of information stand out.

Contacting Microsoft Dynamics GP Technical Support

If you have any questions regarding Reporting Services with Microsoft Dynamics 
GP, you can contact Microsoft Dynamics GP Technical Support using one of the 
following methods:

SQL Server Reporting Services version Report type available

Reporting Services 2005 with latest service pack
Reporting Services 2008 
Reporting Services 2008 R2
Reporting Services 2012

SQL Server Reporting Services reports

Reporting Services 2008 
Reporting Services 2008 R2
Reporting Services 2012

Charts and key performance indicators (KPIs)

Reporting Services 2008 R2
Reporting Services 2012

Map charts

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be especially 
aware of when completing tasks. 

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > Print The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in a 
window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER Small capital letters indicate a key or a key sequence.
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I N T R O D U C T I O N

• Log on to the Microsoft Dynamics GP Support Web site (https://
mbs.microsoft.com/customersource/support/) and choose New Support 
Requests under Assisted Support to send an eSupport request.

• Telephone 1-888-477-7877 (U.S. and Canada only) or +1-701-281-0555.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
https://mbs.microsoft.com/customersource/support/
https://mbs.microsoft.com/customersource/support/
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Chapter 1: Deployment configurations
There are several ways the Reporting Services can be deployed. You can use a 
standard deployment model or a scale-out deployment model. 

You must use Kerberos Authentication with Reporting Services if you are using 
Windows® Authentication and your configuration has SQL Server on one computer 
and the Web server on another computer. For more information see How to use 
Kerberos authentication in SQL Server (http://support.microsoft.com/kb/319723/
en-us).

This chapter includes the following sections.

• Standard deployment model
• Scale-out deployment model

Standard deployment model

A standard deployment model is made up of a single report server instance that 
uses a local or remote SQL Server database engine to host the report server 
database. 

You should consider processing resource and disk space availability when choosing 
where to host the report server database are processing resources and disk space 
availability. Both the report server and the database engine compete for CPU time, 
memory, and disk access. Some report server operations are resource intensive. For 
example, a report server attempts to use all available memory for report rendering 
operations.

Although the use of a report server database may be small initially, disk space 
requirements can grow significantly at run time depending on how you run reports 
and the number of users accessing the report server. 

Single-server configuration
The following diagram shows the standard deployment model of single-server 
configuration. A single-server configuration is where the report server database is 
installed locally so that all server components are on the same computer.

http://support.microsoft.com/kb/319723/en-us 
http://support.microsoft.com/kb/319723/en-us 
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Separate server configuration
The following diagram shows the standard deployment model where the report 
server database is located on a remote server. 

Scale-out deployment model

You can deploy Reporting Services in a scale-out deployment. A report server scale-
out deployment model is made up of multiple report servers that share a single 
report server database. You can run the report servers in a server cluster. The 
database can be installed on a remote SQL Server instance or locally with one of the 
report servers.

To run the report servers as a single virtual server or to use Network Load 
Balancing (NLB), you must use software and tools that support that functionality. 
Reporting Services does not provide server cluster or virtual server management.
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The following diagram shows multiple report servers and report server databases 
deployed in separate server clusters.
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Chapter 2: Reporting Services checklists
Use one of the following checklists to install and set up Reporting Services. Next to 
each step in a checklist is a reference to where you can find more detailed 
information.

This chapter includes the following sections.

• Reporting Services 2005 Native mode setup checklist
• Reporting Services 2008 Native mode setup checklist
• Reporting Services 2008 for Windows SharePoint Services setup checklist
• Reporting Services 2008 for Microsoft Office SharePoint Server setup checklist
• Reporting Services 2008 R2 Native mode setup checklist
• Reporting Services 2008 R2 for Microsoft SharePoint 2010 setup checklist
• Reporting Services 2012 Native mode setup checklist
• Reporting Services 2012 for Microsoft SharePoint 2010 setup checklist

Reporting Services 2005 Native mode setup checklist 

Use this checklist as your guide to installing and setting up Reporting Services 2005 
in the Native mode.

Step Detail

1. Select a Reporting Services deployment 
configuration.

Chapter 1, “Deployment configurations.”

2. Verify system requirements. Requirements on page 17

3. Configure IIS. Configuring IIS for Reporting Services 2005 on page 17

4. Install Reporting Services 2005 with Service 
Pack 2 or later. The configuration options 
available depend whether you are installing 
Reporting Services at the same time as the SQL 
Server database or are installing Reporting 
Services as an additional component.

During the Reporting Services installation, you can specify one of the following options 
as the type of Reporting Services installation to create. 

Install the default configuration Installs a report server instance using the default 
values for the report server databases, service account, and URL reservations. The 
report server instance is ready to use after installation is complete. The report server 
database is created using a local Database Engine instance, and a report server is 
configured to use default values.

Install but do not configure the server Installs the report server program files, 
creates the Report Server service account, and registers the report server Windows 
Management Instrumentation (WMI) provider. After the installation is complete, you 
must create the report server database and configure the report server before it can be 
used. 

Installing Reporting Services 2005 on page 20
This procedure assumes that you have already installed Microsoft SQL Server 2005, 
but not Reporting Services. These instructions are for installing Reporting Services as a 
single-server configuration.

5. Configure Reporting Services 2008 R2. Configuring Reporting Services 2005 on page 21
This step is required if you selected the Install but do not configure the server 
option when installing Reporting Services. 

6. Verify that you can connect to the Report 
Manager.

Starting Report Manager on page 22

7. Deploy predefined Reporting Services 
reports.

Chapter 7, “Deploying Reporting Services reports.”
Use the Reporting Tools Setup window to select the configuration mode, to define 
locations of the Report Server and the Report Manager and deploy reports. 
In Microsoft Dynamics GP, open the Reporting Tools Setup window. (Microsoft 
Dynamics GP menu > Tools > Setup > System > Reporting Tools Setup) 

8. Set up security for Reporting Services. Chapter 8, “Reporting Services Security Setup.”
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Reporting Services 2008 Native mode setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2008 
in the Native mode. 

Step Detail

1. Select a Reporting Services deployment 
configuration.

Chapter 1, “Deployment configurations.”

2. Verify system requirements. Requirements on page 23

3. Configure the Web Server (IIS) role. Configuring Web Server (IIS) for Reporting Services 2008 on page 23

4. Install Reporting Services 2008. The 
configuration options available depend 
whether you are installing Reporting Services 
at the same time as other SQL Server 
components or are installing Reporting 
Services as an additional component.

During the Reporting Services installation, you can specify one of the following options 
as the type of Reporting Services installation to create. 

Native mode default configuration Installs a report server instance using the 
default values for the report server databases, service account, and URL reservations. 
The report server instance is ready to use after installation is complete. The report 
server database is created using a local Database Engine instance, and a report server 
is configured to use default values.

Unconfigured Reporting Services installation Installs the report server program 
files, creates the Report Server service account, and registers the report server 
Windows Management Instrumentation (WMI) provider. After the installation is 
complete, you must create the report server database and configure the report server 
before it can be used. 

Installing Reporting Services 2008 on page 26
This procedure assumes that you have already installed Microsoft SQL Server 2008, 
but not Reporting Services. These instructions are for installing Reporting Services as a 
single-server configuration. 

5. Configure Reporting Services 2008. Configuring Reporting Services 2008 on page 28
This step is required if you selected the Unconfigured Reporting Services 
installation option when installing Reporting Services. 

6. Verify that you can connect to the Report 
Manager.

Starting Report Manager on page 29

7. Deploy predefined Reporting Services 
reports.

Chapter 7, “Deploying Reporting Services reports.”
Use the Reporting Tools Setup window to select the configuration mode, to define 
locations of the Report Server and the Report Manager, and deploy reports. 
In Microsoft Dynamics GP, open the Reporting Tools Setup window. (Microsoft 
Dynamics GP menu > Tools > Setup > System > Reporting Tools Setup) 

8. Set up security for Reporting Services. Chapter 8, “Reporting Services Security Setup.”
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Reporting Services 2008 for Windows SharePoint 
Services setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2008 
in the SharePoint Integrated mode, and creating a site collection and reports library 
for Windows SharePoint Services.

Step Detail

1. Select a Reporting Services deployment 
configuration.

Chapter 1, “Deployment configurations.”

2. Verify system requirements. Requirements on page 23

3. Configure the Web Server (IIS) role. Configuring Web Server (IIS) for Reporting Services 2008 on page 23

4. Install Reporting Services 2008. The 
configuration options available depend 
whether you are installing Reporting Services 
at the same time as other SQL Server 
components or are installing Reporting 
Services as an additional component.

During the Reporting Services installation, you can specify one of the following options 
as the type of Reporting Services installation to create. 

SharePoint Integrated mode default configuration Installs a report server 
instance using the default values for the report server databases, service account, and 
URL reservations. The report server database is created in a format that supports 
content storage and addressing from a SharePoint site.

Unconfigured Reporting Services installation Installs the report server program 
files, creates the Report Server service account, and registers the report server 
Windows Management Instrumentation (WMI) provider. After the installation is 
complete, you must create the report server database and configure the report server 
before it can be used. 

Installing Reporting Services 2008 on page 26
This procedure assumes that you have already installed Microsoft SQL Server 2008, 
but not Reporting Services. These instructions are for installing Reporting Services as a 
single-server configuration. 

5. Configure Reporting Services 2008 R2. Configuring Reporting Services 2008 on page 28
This step is required if you selected the Unconfigured Reporting Services 
installation option when installing Reporting Services. 

6. Verify that you can connect to the Report 
Server.

Starting Report Server on page 29

7. Create a Reports site. Creating a Reports site in Windows SharePoint Services on page 29

8. Create a Reports Library. Creating a Reports Library in Windows SharePoint Services on page 30

9. Install the SQL Server 2008 Reporting 
Services Add-in for Microsoft SharePoint 
Technologies.

Installing SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint 
Technologies on page 30.
The SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint Technologies 
allows you to integrate your reporting environment with Microsoft SharePoint.

10. Verify that the Reporting Services 
Integration feature is activated.

Activating Report Server Integration on page 31

11. Configure Report Services Integration. Configuring Report Server Integration on page 31

12. Deploy predefined Reporting Services 
reports.

Chapter 7, “Deploying Reporting Services reports.”
In Microsoft Dynamics GP, open the Reporting Tools Setup window. (Microsoft 
Dynamics GP menu > Tools > Setup > System > Reporting Tools Setup) 

Use the Reporting Tools Setup window to select the configuration mode, to define 
locations of the Report Server, the Report Manager, or the Reports Library, and deploy 
reports. 

13. Set up security for Reporting Services. Chapter 8, “Reporting Services Security Setup.”
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Reporting Services 2008 for Microsoft Office 
SharePoint Server setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2008 
in the SharePoint Integrated mode, and storing reports in Microsoft Office 
SharePoint Server. 

Step Detail

1. Select a Reporting Services deployment 
configuration.

Chapter 1, “Deployment configurations.”

2. Verify system requirements. Requirements on page 23

3. Configure the Web Server (IIS) role. Configuring Web Server (IIS) for Reporting Services 2008 on page 23

4. Install Reporting Services 2008 R2. The 
configuration options available depend 
whether you are installing Reporting Services 
at the same time as other SQL Server 
components or are installing Reporting 
Services as an additional component.

During the Reporting Services installation, you can specify one of the following options 
as the type of Reporting Services installation to create. 

SharePoint Integrated mode default configuration Installs a report server 
instance using the default values for the report server databases, service account, and 
URL reservations. The report server database is created in a format that supports 
content storage and addressing from a SharePoint site.

Unconfigured Reporting Services installation Installs the report server program 
files, creates the Report Server service account, and registers the report server 
Windows Management Instrumentation (WMI) provider. After the installation is 
complete, you must create the report server database and configure the report server 
before it can be used. 

Installing Reporting Services 2008 on page 26
This procedure assumes that you have already installed Microsoft SQL Server 2008, 
but not Reporting Services. These instructions are for installing Reporting Services as a 
single-server configuration. 

5. Configure Reporting Services 2008. This step is required if you selected the Unconfigured Reporting Services 
installation option when installing Reporting Services. 

6. Verify that you can connect to the Report 
Server.

Starting Report Server on page 29

7. Create a site collection. Storing reports in Microsoft Office SharePoint Server 2007 on page 30

9. Install the SQL Server 2008 Reporting 
Services Add-in for Microsoft SharePoint 
Technologies.

Installing SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint 
Technologies on page 30.
The SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint Technologies 
allows you to integrate your reporting environment with Microsoft SharePoint.

10. Verify that the Reporting Services 
Integration feature is activated.

Activating Report Server Integration on page 31

11. Configure Report Services Integration. Configuring Report Server Integration on page 31

12. Deploy predefined Reporting Services 
reports.

Chapter 7, “Deploying Reporting Services reports.”
In Microsoft Dynamics GP, open the Reporting Tools Setup window. (Microsoft 
Dynamics GP menu > Tools > Setup > System > Reporting Tools Setup) 

Use the Reporting Tools Setup window to select the configuration mode, to define 
locations of the Report Server, the Report Manager, or the Reports Library, and deploy 
reports. 

13. Set up security for Reporting Services. Chapter 8, “Reporting Services Security Setup.”



S Q L S E R V E R R E P O R T I N G S E R V I C E S G U I D E 13

C H A P T E R  2    R E P O R T I N G  S E R V I C E S  C H E C K L I S T S

Reporting Services 2008 R2 Native mode setup 
checklist

Use this checklist as your guide to installing and setting up Reporting Services 2008 
R2 in the Native mode. 

Step Detail

1. Select a Reporting Services deployment 
configuration.

Chapter 1, “Deployment configurations.”

2. Verify system requirements. Requirements on page 33

3. Configure the Web Server (IIS) role. Configuring Web Server (IIS) role for Reporting Services 2008 R2 on page 34

4. Install Reporting Services 2008 R2. The 
configuration options available depend 
whether you are installing Reporting Services 
at the same time as other SQL Server 
components or are installing Reporting 
Services as an additional component.

During the Reporting Services installation, you can specify one of the following options 
as the type of Reporting Services installation to create. 

Native mode default configuration Installs a report server instance using the 
default values for the report server databases, service account, and URL reservations. 
The report server instance is ready to use after installation is complete. The report 
server database is created using a local Database Engine instance, and a report server 
is configured to use default values.

Note: Microsoft Dynamics CRM supports only the native mode of deployment of 
Reporting Services 2008 R2.

Unconfigured Reporting Services installation Installs the report server program 
files, creates the Report Server service account, and registers the report server 
Windows Management Instrumentation (WMI) provider. After the installation is 
complete, you must create the report server database and configure the report server 
before it can be used. 

Installing Reporting Services 2008 R2 on page 36
This procedure assumes that you have already installed Microsoft SQL Server 2008 R2, 
but not Reporting Services. These instructions are for installing Reporting Services as a 
single-server configuration. 

5. Configure Reporting Services 2008 R2. Configuring Reporting Services 2008 R2 on page 38
This step is required if you selected the Unconfigured Reporting Services 
installation option when installing Reporting Services. 

6. Verify that you can connect to the Report 
Manager.

Starting Report Manager on page 39

7. Deploy predefined Reporting Services 
reports.

Chapter 7, “Deploying Reporting Services reports.”
Use the Reporting Tools Setup window to select the configuration mode, to define 
locations of the Report Server, the Report Manager, or the Reports Library, and deploy 
reports. If you are using Microsoft Dynamics CRM 2011 or later, you can enter location 
of the CRM services and the name of the organization. In Microsoft Dynamics GP, open 
the Reporting Tools Setup window. (Microsoft Dynamics GP menu > Tools > 
Setup > System > Reporting Tools Setup) 

8. Set up security for Reporting Services. Chapter 8, “Reporting Services Security Setup.”
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Reporting Services 2008 R2 for Microsoft SharePoint 
2010 setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2008 
R2 in the SharePoint Integrated mode, and creating a site collection and reports 
library for Microsoft SharePoint 2010. 

Step Detail

1. Select a Reporting Services deployment 
configuration.

Chapter 1, “Deployment configurations.”

2. Verify system requirements. Requirements on page 33

3. Configure Web Server (IIS) role. Configuring Web Server (IIS) role for Reporting Services 2008 R2 on page 34

4. Install Reporting Services 2008 R2. The 
configuration options available depend 
whether you are installing Reporting Services 
at the same time as other SQL Server 
components or are installing Reporting 
Services as an additional component.

During the Reporting Services installation, you can specify one of the following options 
as the type of Reporting Services installation to create. 

SharePoint Integrated mode default configuration Installs a report server 
instance using the default values for the report server databases, service account, and 
URL reservations. The report server database is created in a format that supports 
content storage and addressing from a SharePoint site.

Note: Microsoft Dynamics CRM supports only the native mode of deployment of 
Reporting Services 2008 R2.

Unconfigured Reporting Services installation Installs the report server program 
files, creates the Report Server service account, and registers the report server 
Windows Management Instrumentation (WMI) provider. After the installation is 
complete, you must create the report server database and configure the report server 
before it can be used. 

Installing Reporting Services 2008 R2 on page 36
This procedure assumes that you have already installed Microsoft SQL Server 2008 R2, 
but not Reporting Services. These instructions are for installing Reporting Services as a 
single-server configuration. 

5. Configure Reporting Services 2008 R2. Configuring Reporting Services 2008 R2 on page 38
This step is required if you selected the Unconfigured Reporting Services 
installation option when installing Reporting Services. 

6. Verify that you can connect to the Report 
Server.

Starting Report Server on page 39

7. Create a Reports site. Creating a Reports site in Microsoft SharePoint 2010 on page 39

8. Create a Reports Library. Creating a Reports Library in Microsoft SharePoint 2010 on page 39

9. Install the SQL Server Reporting Services 
SharePoint 2010 Add-in.

Installing SQL Server Reporting Services Add-in for SharePoint 2010 Technologies on 
page 40
The SQL Server Reporting Services SharePoint 2010 Add-in is installed as a 
prerequisite for SharePoint Foundation and SharePoint Server if Reporting Services is 
already installed. If you install Reporting Services 2008 after installing SharePoint, you 
can use the Microsoft SharePoint 2010 Products Preparation Tool to install the add-in.

10. Configure Report Services Integration. Configuring Reporting Services Integration on page 41

11. Deploy predefined Reporting Services 
reports.

Chapter 7, “Deploying Reporting Services reports.”
In Microsoft Dynamics GP, open the Reporting Tools Setup window. (Microsoft 
Dynamics GP menu > Tools > Setup > System > Reporting Tools Setup) 

Use the Reporting Tools Setup window to select the configuration mode, to define 
locations of the Report Server, or the Reports Library, and deploy reports. 

12. Set up security for Reporting Services. Chapter 8, “Reporting Services Security Setup.”
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Reporting Services 2012 Native mode setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2012 
in the Native mode. 

Step Detail

1. Select a Reporting Services deployment 
configuration.

Chapter 1, “Deployment configurations.”

2. Verify system requirements. Requirements on page 43

3. Configure the Web Server (IIS) role. Configuring Web Server (IIS) role for Reporting Services 2012 on page 44

4. Install Reporting Services 2012. The 
configuration options available depend 
whether you are installing Reporting Services 
at the same time as other SQL Server 
components or are installing Reporting 
Services as an additional component.

During the Reporting Services installation, you can specify one of the following options 
as the type of Reporting Services installation to create. 

Install and configure Installs a report server instance using the default values for 
the report server databases, service account, and URL reservations. The report server 
instance is ready to use after installation is complete. The report server database is 
created using a local Database Engine instance, and a report server is configured to 
use default values.

Note: Microsoft Dynamics CRM supports only the native mode of deployment of 
Reporting Services 2012.

Install only Installs the report server program files, creates the Report Server service 
account, and registers the report server Windows Management Instrumentation (WMI) 
provider. After the installation is complete, you must create the report server database 
and configure the report server before it can be used. 

Installing Reporting Services 2012 on page 46
This procedure assumes that you have already installed Microsoft SQL Server 2012, 
but not Reporting Services. These instructions are for installing Reporting Services as a 
single-server configuration. 

5. Configure Reporting Services 2012. Configuring Reporting Services 2012 in Native mode on page 47
This step is required if you selected the Install only option when installing Reporting 
Services. 

6. Verify that you can connect to the Report 
Manager.

Starting Report Manager on page 49

7. Deploy predefined Reporting Services 
reports.

Chapter 7, “Deploying Reporting Services reports.”
Use the Reporting Tools Setup window to select the configuration mode, to define 
locations of the Report Server, the Report Manager, or the Reports Library, and deploy 
reports. If you are using Microsoft Dynamics CRM 2011 or later, you can enter location 
of the CRM services and the name of the organization. In Microsoft Dynamics GP, open 
the Reporting Tools Setup window. (Microsoft Dynamics GP menu > Tools > 
Setup > System > Reporting Tools Setup) 

8. Set up security for Reporting Services. Chapter 8, “Reporting Services Security Setup.”
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Reporting Services 2012 for Microsoft SharePoint 
2010 setup checklist

Use this checklist as your guide to installing and setting up Reporting Services 2012 
in the SharePoint Integrated mode, and creating a site collection and reports library 
for Microsoft SharePoint 2010. 

Step Detail

1. Select a Reporting Services deployment 
configuration.

Chapter 1, “Deployment configurations.”

2. Verify system requirements. Requirements on page 43

3. Configure Web Server (IIS) role. Configuring Web Server (IIS) role for Reporting Services 2012 on page 44

4. Install Reporting Services 2012. During the Reporting Services installation for the SharePoint Integrated mode, the 
report server program files are installed. After the installation is complete, you must 
use the SharePoint Central Administration to complete the configuration. Verify the 
SQL Server Reporting Services service is started and create at least one SQL Server 
Reporting Services service application.

Note: Microsoft Dynamics CRM supports only the native mode of deployment of 
Reporting Services 2012.

Installing Reporting Services 2012 on page 46
This procedure assumes that you have already installed Microsoft SQL Server 2012, 
but not Reporting Services. These instructions are for installing Reporting Services as a 
single-server configuration. 

5. Configure Reporting Services 2012 in 
SharePoint Integrated mode.

Installing the Reporting Services SharePoint service on page 49
Starting the Reporting Services SharePoint service on page 49
Creating a Reporting Services service application on page 50
This step is required. 

7. Create a Reports site. Creating a Reports site in Microsoft SharePoint 2010 on page 51

8. Create a Reports Library. Creating a Reports Library in Microsoft SharePoint 2010 on page 51

10. Configure Report Services Integration. Configuring Reporting Services Integration on page 52

11. Activate Claims to Windows Token Service Activating the Claims to Windows Token Service on page 52

12. Deploy predefined Reporting Services 
reports.

Chapter 7, “Deploying Reporting Services reports.”
In Microsoft Dynamics GP, open the Reporting Tools Setup window. (Microsoft 
Dynamics GP menu > Tools > Setup > System > Reporting Tools Setup) 

Use the Reporting Tools Setup window to select the configuration mode, to define 
locations of the Report Server, or the Reports Library, and deploy reports. 

13. Set up security for Reporting Services. Chapter 8, “Reporting Services Security Setup.”
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Chapter 3: Installing Reporting Services 2005
Use the information in this chapter to install and configure Reporting Services 2005. 
This chapter contains the following sections:

• Requirements
• Configuring IIS for Reporting Services 2005
• Installing Reporting Services 2005
• Configuring Reporting Services 2005
• Starting Report Manager

Requirements

The following components must be installed before you can install SQL Server 
Reporting Services 2005 to use with Microsoft Dynamics GP.

Configuring IIS for Reporting Services 2005

Internet Information Services (IIS) must be installed before Reporting Services 
because a Web site and a Web services are created during the Reporting Services 
installation. IIS is a set of Internet-based services for servers using Microsoft 
Windows. IIS hosts Web sites and Web services.

To configure IIS for Windows Server 2003:
1. Open the Add or Remove Programs control panel.

(Start > Control Panel > Add or Remove Programs)

2. Click Add/Remove Windows Components to open the Windows Components 
Wizard. 

3. Mark Applications Server in the Components list and click the Details button.

Item Requirements

Operating system
32-bit and 64-bit supported

Server
Windows Server® 2003 with latest service pack
Windows Server 2008 with latest service pack
Windows Server 2008 R2 with latest service pack

Client
Windows Vista® with latest service pack
Windows 7 with latest service pack

Database Microsoft SQL Server 2005 with service pack 2 or later
If you are using WIndows Server 2008 R2, you must use 
Microsoft SQL Server 2005 with service pack 3 or later.

Web server for Reporting 
Services 2005

Internet Information Services (IIS) 6.0 
IIS 7.0 on Windows Server 2008

 Web browser Internet Explorer 8
Internet Explorer 7

Microsoft Dynamics GP Microsoft Dynamics GP 2010
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4. Mark the following Application Server subcomponents.

• ASP.Net
• Enable network COM + access
• Enable network DTC access
• Internet Information Services (IIS)

5. Select Internet Information Services (IIS) and click the Details button.

6. Mark the following Internet Information Services (IIS) subcomponents.

• Common Files
• Internet Information Services Manager

7. Click OK. 

The additional components are installed. You may be asked to insert the 
Windows Server 2003 product CD to continue the installation.

To configure Web Server (IIS) for Windows Server 2008:
1. Open the Server Manager.

(Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. Click Next to 
continue.

5. Review the information about the Web Server (IIS) role. Click Next to continue.

6. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

7. In the Select Role Services window, select the following components for the 
Management Tools role service.

• IIS Management Console
• IIS 6 Management Compatibility

Role Service component Required subcomponent

Common Http Features Static Content
Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Application Development ASP.Net
.Net Extensibility
ISAPI Extensions
ISAPI Filters

Security Windows Authorization
Request Filtering
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8. Click Next.

9. Review the installation messages, and then click Install.

10. After you have viewed the installation results, click Close.

To configure Web Server (IIS) for Windows Server 2008 
R2:
1. Open the Server Manager.

(Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. 

5. In the message dialog, click Add Required Features to add features required for 
the Web Server (IIS) role.

6. Click Next to continue.

7. Review the information about the Web Server (IIS) role. Click Next to continue.

8. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

9. Click Next.

Role Service component Required subcomponent

Common Http Features Static Content
Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Application Development ASP.Net
.Net Extensibility
ISAPI Extensions
ISAPI Filters
Server Side includes

Health and Diagnostics HTTP Logging
Request Monitor

Security Basic Authorization
Windows Authorization
Digest Authorization
Request Filtering

Performance Static Content Compression

Management Tools IIS Management Console
IIS 6 Management Compatibility

ISS 6 Metabase Compatibility
ISS 6 WMI Compatibility
ISS 6 Scripting Tools
ISS 6 Management Console
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10. Review the installation messages, and then click Install.

11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are 
displayed.

13. Be sure that .NET Framework 3.5 Features is installed if you are using Windows 
Server 2008 R2. If it isn’t, use Add Features in Server Manager to add the 
features.

Installing Reporting Services 2005

You can follow the instructions in this section if you have not yet installed Microsoft 
SQL Server Reporting Services. This procedure assumes that you have already 
installed Microsoft SQL Server 2005, but not Reporting Services. These instructions 
are for installing Reporting Services as a single-server configuration. A single-server 
configuration is where the report server database is installed locally so that all 
server components are on the same computer. For more information about 
configurations, see Chapter 1, “Deployment configurations.”

When running the SQL Server installation program, you must be logged in as a 
member of the local system administrators group. Your SQL Server login account 
must have administrator permissions in SQL Server so you can create logins, roles 
and databases, and assign roles to logins.

The SQL Server that hosts your Microsoft Dynamics GP data must be using mixed-mode 
authentication. (Mixed-mode authentication allows you to use either Windows 
Authentication or SQL Authentication to access the SQL Server.).

To install Reporting Services 2005:
1. Insert the SQL Server 2005 media. The main SQL Server installation screen 

should appear. If you do not see this screen, browse the media and double-click 
the Splash.hta file.

2. Click Run in the SQL Server Installation Wizard.

3. Mark the option to accept the terms of the End-User License Agreement, and 
then click Next.

4. In the Installing Prerequisites window, click Next after the components that are 
required are installed.

5. In the Welcome to the Microsoft SQL Server Installation Wizard window, click 
Next.

6. Your computer is scanned for conditions that may cause possible installation 
problems. To proceed with the installation, click Next in the System 
Configuration Check window. 

If the IIS Feature Requirement has an error or warning, you must be sure that IIS is 
configured correctly. 

7. Accept the entries in the Name and Company fields in the Registration 
Information window, and click Next.
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8. In the Components to Install window, select Reporting Services, and click 
Next. 

9. In the Instance Name window, select a default or named instance for your 
installation. 

• Select Default instance to install Reporting Services on your default 
instance of SQL server, and click Next.

• Select Named Instance and enter the instance name to install Reporting 
Services to another instance of SQL server, and click Next.

10. In the Services Accounts window, select Use the built-in system account 
option. Click Next.

11. In the Report Server Installation Options window, click Next. 

12. The Setup Progress window appears, allowing you to view the status of the 
installation. Click Next after the installation is completed.

13. In the Completing the Microsoft SQL Server Installation Wizard window, click 
Finish to exit the installation wizard.

14. Restart the computer if you are instructed to do so.

15. Apply Microsoft SQL Server 2005 service pack 2 or later before you configure 
SQL Server Reporting Services.

Configuring Reporting Services 2005

After installing Reporting Services, use the Report Server Configuration Manager to 
configure and start Reporting Services. The Report Server Configuration Manager 
has a number of pages that you can use to configure Reporting Services.

Each page name is shown in the page menu. If the icon next to the page name is 
green with a check mark, the items on the page are configured correctly. If the icon 
has an X, the items aren’t configured correctly. 

To configure Reporting Services 2005:
1. Start Report Server Configuration Manager.

(Start > All Programs > Microsoft SQL Server 2005 > Configuration Tools > 
Reporting Services Configuration)

2. Enter the name of a server and select an instance to connect to in the Report 
Server Installation Instance Selection window. Click Connect.

If you installed Reporting Services on a Web server where SQL Server isn’t installed, 
connect to the reporting server and not the SQL server.

3. If Reporting Services isn’t running, click the Start button in the Report Server 
Status page. The Report Server Status page displays status information about 
the instance that you’ve selected.
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4. In the navigation pane, click Report Server Virtual Directory to open the 
Report Server Virtual Directory Setting page. This page allows you to view and 
change the name of the virtual directory used by the Reporting Services Web 
service. 

5. Click New to create a new virtual directory.

6. In the Create a New Virtual Directory window, select the Web site where the 
virtual directory will be created, and click OK.

7. In the navigation pane, click Report Manager Virtual Directory to open the 
Report Manager Virtual Directory Setting page.

8. Click New to create a new reports virtual directory.

9. In the Create a New Virtual Directory window, select the Web site where the 
virtual directory will be created, and click OK.

10. In the navigation pane, click Windows Service Identity to open the Windows 
Service Identity page. Verify that the service account is using the local system 
account.

11. In the navigation pane, click Web Service Identity to open the Web Service 
Identity page. Click Apply.

12. In the navigation pane, click Database Setup to open the Database Connection 
page. 

13. Enter the server name, and click Connect.

14. The SQL Server Connection Dialog window opens, where you can specify the 
credentials to be used to connect to the SQL server. Since the local system 
account is used to access the SQL server, click OK without changing the default 
options.

15. If the SQL server name appears as the Server Name field in the Database 
Connection page, the connection to the server is successful.

16. Click New to open the SQL Server Connection Dialog window. Click OK to 
create the database at the SQL server.

17. Click Apply in the Database Connection page to apply all the changes to the 
SQL server and Reporting Services configuration.

Starting Report Manager 

Report Manager is installed during setup on the same computer as the report server. 
You should verify that you can connect to the Report Manager.

To start Report Manager:
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By 
default, the URL is http://<servername>/reports.
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Chapter 4: Installing Reporting Services 2008
Use the information in this chapter to install and configure Reporting Services 2008. 
This chapter contains the following sections:

• Requirements
• Configuring Web Server (IIS) for Reporting Services 2008
• Installing Reporting Services 2008
• Configuring Reporting Services 2008
• Starting Report Manager
• Starting Report Server
• Creating a Reports site in Windows SharePoint Services
• Creating a Reports Library in Windows SharePoint Services
• Storing reports in Microsoft Office SharePoint Server 2007
• Installing SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint 

Technologies
• Activating Report Server Integration
• Configuring Report Server Integration

Requirements

The following components must be installed before you can install SQL Server 
Reporting Services 2008 to use with Microsoft Dynamics GP.

If you are using Reporting Services 2008, you can use either the SQL Server 2008 database 
engine, SQL Server 2008 R2 database engine, or the SQL Server 2005 database engine for 
Microsoft Dynamics GP.

Configuring Web Server (IIS) for Reporting Services 
2008

Internet Information Services (IIS) must be installed before Reporting Services 
because a Web site and a Web services are created during the Reporting Services 
installation. IIS is a set of Internet-based services for servers using Microsoft 
Windows. IIS hosts Web sites and Web services.

Item Requirements

Operating system
32-bit and 64-bit supported

Server
Windows Server 2003 with latest service pack
Windows Server 2008 with latest service pack
Windows Server 2008 R2 with latest service pack

Client
Windows Vista with latest service pack
Windows 7 with latest service pack

Database Microsoft SQL Server 2008 with service pack 1 or later
Microsoft SQL Server 2008 R2

SharePoint Windows SharePoint Services 3.0 or later
Microsoft Office SharePoint Server, Enterprise Edition
Microsoft SharePoint Foundation 2010
Microsoft SharePoint Server 2010

 Web browser Internet Explorer 9
Internet Explorer 8
Internet Explorer 7

Microsoft Dynamics GP Microsoft Dynamics GP 2010 or later
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To configure IIS for Windows Server 2003:
1. Open the Add or Remove Programs control panel.

(Start > Control Panel > Add or Remove Programs)

2. Click Add/Remove Windows Components to open the Windows Components 
Wizard. 

3. Mark Applications Server in the Components list and click the Details button.

4. Mark the following Application Server subcomponents.

• ASP.Net
• Enable network COM + access
• Enable network DTC access
• Internet Information Services (IIS)

5. Select Internet Information Services (IIS) and click the Details button.

6. Mark the following Internet Information Services (IIS) subcomponents.

• Common Files
• Internet Information Services Manager

7. Click OK. 

The additional components are installed. You may be asked to insert the 
Windows Server 2003 product CD to continue the installation.

To configure Web Server (IIS) for Windows Server 2008:
1. Open the Server Manager.

(Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. 

5. In the message dialog, click Add Required Features to add features required for 
the Web Server (IIS) role.

6. Click Next to continue.

7. Review the information about the Web Server (IIS) role. Click Next to continue.
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8. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

9. Click Next.

10. Review the installation messages, and then click Install.

11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are 
displayed.

To configure Web Server (IIS) for Windows Server 2008 
R2:
1. Open the Server Manager.

(Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. 

5. In the message dialog, click Add Required Features to add features required for 
the Web Server (IIS) role.

6. Click Next to continue.

7. Review the information about the Web Server (IIS) role. Click Next to continue.

Role Service component Required subcomponent

Common HTTP Features Static Content
Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Application Development ASP.Net
.NET Extensibility
ISAPI Extensions
ISAPI Filters
Server Side includes

Health and Diagnostics HTTP Logging
Request Monitor

Security Basic Authorization
Windows Authorization
Digest Authorization
Request Filtering

Performance Static Content Compression
IIS Management Console
IIS 6 Management Compatibility

ISS 6 Metabase Compatibility
ISS 6 WMI Compatibility
ISS 6 Scripting Tools
ISS 6 Management Console
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8. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

9. Click Next.

10. Review the installation messages, and then click Install.

11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are 
displayed.

13. Be sure that .NET Framework 3.5 Features is installed if you are using Windows 
Server 2008 R2. If it isn’t, use Add Features in Server Manager to add the 
features

Installing Reporting Services 2008

You can follow the instructions in this section if you have not yet installed Microsoft 
SQL Server Reporting Services. This procedure assumes that you have already 
installed Microsoft SQL Server 2008, but not Reporting Services. These instructions 
are for installing Reporting Services as a single-server configuration. A single-server 
configuration is where the report server database is installed locally so that all 
server components are on the same computer. For more information about 
configurations, see Chapter 1, “Deployment configurations.”

When running the SQL Server installation program, you must be logged in as a 
member of the local system administrators group. Your SQL Server login account 
must have administrator permissions in SQL Server so you can create logins, roles 
and databases, and assign roles to logins.

Role Service component Required subcomponent

Common HTTP Features Static Content
Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Application Development ASP.Net
.NET Extensibility
ISAPI Extensions
ISAPI Filters
Server Side includes

Health and Diagnostics HTTP Logging
Request Monitor

Security Basic Authorization
Windows Authorization
Digest Authorization
Request Filtering

Performance Static Content Compression

Management Tools IIS Management Console
IIS 6 Management Compatibility

ISS 6 Metabase Compatibility
ISS 6 WMI Compatibility
ISS 6 Scripting Tools
ISS 6 Management Console
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The SQL Server that hosts your Microsoft Dynamics GP data must be using mixed-mode 
authentication. (Mixed-mode authentication allows you to use either Windows 
Authentication or SQL Authentication to access the SQL Server.)

To install Reporting Services 2008:
1. Insert the SQL Server 2008 media. The main SQL Server installation screen 

should appear. If you do not see this screen, browse the media and double-click 
the setup.exe file.

2. Click Yes to make changes to your computer if you are using User Account 
Control. 

3. In the SQL Server Installation Center, click Installation.

4. Click New SQL Server stand-alone installation or add features to an existing 
installation.

5. In the Setup Support Rules window, click OK.

6. In the Setup Support Files window, click Install.

7. Your computer is scanned for conditions that may cause possible installation 
problems. To proceed with the installation, click Next. 

8. In the Installation Type window, select Add features to an existing instance of 
SQL Server 2008 and click Next.

9. In the Feature Selection window, select Reporting Services and any other 
feature you want to install. Click Next.

10. In the Disk Requirements window, click Next.

11. In the Server Configuration window, enter the Account Name. Click Next.

12. In the Reporting Services Configuration window, click Next.

You will have to configure the report server using the Reporting Services 
Configuration Manager after installing Reporting Services.

13. In the Error and Usage Reporting window, click Next.

14. In the Installation Rules window, click Next.

15. In the Ready to Install window, click Install. 

16. The Installation Progress window appears, allowing you to view the status of 
the installation. Click Next after the installation is completed.

17. In the Complete window, click Close to exit the installation wizard.

18. Restart the computer if you are instructed to do so.
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Configuring Reporting Services 2008

Use the Report Server Configuration Manager to configure and start Reporting 
Services in Native mode. The Report Server Configuration Manager has a number 
of pages that you can use to configure Reporting Services.

To configure Reporting Services 2008:
1. Start Reporting Services Configuration Manager.

(Start > All Programs > Microsoft SQL Server 2008 > Configuration Tools > 
Reporting Services Configuration Manager)

2. Click Yes to make changes to your computer if you are using User Account 
Control. 

3. Enter the name of a server and select an instance to connect to a report server 
instance. Click Connect.

If you installed Reporting Services on a Web server where SQL Server isn’t installed, 
connect to the reporting server and not the SQL server.

4. If Reporting Services isn’t running, click the Start button in the Report Server 
Status page. The Report Server Status page displays status information about 
the instance that you’ve selected.

5. In the navigation pane, click Service Account to open the page. Be sure that the 
Use the built-in account option is selected.

6. In the navigation pane, click Web Service URL to open the Web Service URL 
page. This page allows you to view and change the name of the virtual 
directory used by the Reporting Services Web service. 

7. Click Apply to create a new virtual directory.

8. In the navigation pane, click Database to open the Report Server Database 
page. 

9. Click Change Database.

10. Select to create a new report server database, and click Next.

11. Select Authentication type and specify the user name and password, if 
necessary. Click Next.

12. Specify the database name and specify the Report Server mode. Click Next.

13. Select Authentication type and specify the user name and password for your 
credentials, if necessary. Click Next.

14. Verify the database information. Click Next.

15. After the database is configured, click Finish.
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16. If you selected Native mode for your report server database, click Report 
Manager URL to open the Report Manager URL page in the navigation pane. 
Click Apply.

17. Click Exit.

Starting Report Manager 

Report Manager is installed during setup on the same computer as the report server. 
If you selected Native mode for your report server database, you should verify that 
you can connect to the Report Manager.

To start Report Manager:
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By 
default, the URL is http://<ComputerName>/Reports

Starting Report Server 

If you selected the SharePoint Integrated mode for your report server database, you 
should verify that you can connect to the Report Server.

To start Report Server:
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By 
default, the URL is http://<ComputerName>/ReportServer.

Creating a Reports site in Windows SharePoint 
Services

If you selected the SharePoint Integrated mode for your report server database, you 
can store reports in a SharePoint reports library. If you don’t have a site in Windows 
SharePoint Services that serves as a central location to manage Reporting Services 
reports, create a Reports site.

To create a Reports site in Windows SharePoint Services:
1. Type http://<ServerName> in the address field of Internet Explorer. 

2. Click View All Site Content.

3. Click Create.

4. Under Web Pages, click Sites and Workspaces. 

5. In the New SharePoint Site page, enter a title and description of the site.

6. Enter the URL name. For example, http://<ServerName>/Reports.

7. Select Document Workspace as the template.

8. Click Create.
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Creating a Reports Library in Windows SharePoint 
Services

After creating a Reports site in Windows SharePoint Services, you need to create a 
reports library. A reports library is a location on the Reports site where you can store 
your Reporting Services reports.

To create a Reports Library in Windows SharePoint 
Services:
1. Type http://<ServerName>/Reports in the address field of Internet Explorer. 

2. Click View All Site Content.

3. Click Create.

4. Under Libraries, click Document Library.

5. In the New page, enter a name and a description.

6. Select None as the document template.

7. Click Create.

Storing reports in Microsoft Office SharePoint Server 
2007

The Report Center is automatically created when you install Microsoft Office 
SharePoint Server, Enterprise Edition. The Report Center is a site that serves as a 
central location to manage business-critical information sources, such as Microsoft 
SQL Server Reporting Service reports and spreadsheets. A reports library is also 
automatically created. 

The Report Center site is available at the same level of navigation as the top-level 
portal site. With the appropriate permissions, you can create a Report Center site 
within a team, department, or organization site. You also can create additional 
report libraries if you choose. For more information, see your Office SharePoint 
Server 2007 documentation.

Installing SQL Server 2008 Reporting Services Add-in 
for Microsoft SharePoint Technologies

The SQL Server 2008 Reporting Services Add-in for Microsoft SharePoint 
Technologies allows you to integrate your reporting environment with Microsoft 
SharePoint. Once you install the add-in and configure your servers for integration, 
you can publish Reporting Services reports to a reports library and then view and 
manage the reports from a SharePoint site.

Installing the SQL Server 2008 Reporting Services Add-in will activate the report 
server integration feature for all existing site collections. If the root site is not 
enabled or if you do not have a site collection defined when the Reporting Services 
Add-in is installed, you must activate the report server integration settings 
manually. 
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To install the SQL Server 2008 Reporting Services Add-in 
for Microsoft SharePoint Technologies:
1. Download the SQL Server Reporting Services Add-in for SharePoint 

Technologies from http://www.microsoft.com/downloads.

2. In the welcome window, click Next.

3. Accept the license agreement.

4. Enter registration information and click Next.

5. Click Install.

6. After the add-in is installed, click Finish.

Activating Report Server Integration

The Report Server Integration feature is automatically activated after you install the 
Microsoft SQL Server 2008 Reporting Services Add-in for SharePoint products. By 
default, the Reporting Services Add-in is activated for the root site collection of the 
local SharePoint Web application. If the root site is not enabled or if you do not have 
a site collection defined when the Reporting Services Add-in is installed, you must 
activate the report server integration settings manually.

If the Reporting Server Integration feature does not appear in the site collection 
feature list, the Reporting Services Add-in is not installed. To verify installation, 
view the list of installed applications in Microsoft Windows Control Panel. If the 
Reporting Services Add-in is installed, follow the instructions in this topic to 
activate the feature.

To activate the Report Server Integration feature:
1. Type http://<ServerName> in the address field of Internet Explorer. 

Go to the Site Settings page (Site Actions > Site Settings) for the top-level web 
site.

2. Under Site Collection Administration in the Site Settings page, click Site 
collection features.

3. Be sure that the Report Server Integration Feature is activated.

Configuring Report Server Integration

You must specify integration settings that determine the connection between 
SharePoint and a report server. The settings that you specify are stored in the 
configuration database. You must be an administrator on the SharePoint farm to 
configure report server integration. You also must have a target report server that is 
already connected to a report server database that was created for SharePoint 
integrated.

If you don’t have the SQL Server Reporting Services SharePoint Add-in installed, 
the configuration pages and general integration are not available.
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To configure Report Services Integration:
1. Open SharePoint Central Administration. 

(Start > Administrative Tools > SharePoint Central 3.0 Administration)

2. Click Application Management.

3. Under the Reporting Services heading, click Grant database access. 

4. In the Grant Database Access page, specify the server name and the instance. 
Click OK.

5. Enter your credentials and click OK.

6. Under the Reporting Services heading, click Manage integration settings. 

7. In the Reporting Services Integration page, specify the URL for the report server 
web service. For example, http://<ServerName> /ReportServer)

8. Select the authentication mode. Click OK.
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Chapter 5: Installing Reporting Services 2008 R2
Use the information in this chapter to install and configure Reporting Services 2008 
R2. This chapter contains the following sections:

• Requirements
• Microsoft Dynamics GP CRM requirements
• Configuring Web Server (IIS) role for Reporting Services 2008 R2
• Installing Reporting Services 2008 R2
• Configuring Reporting Services 2008 R2
• Starting Report Manager
• Starting Report Server
• Creating a Reports site in Microsoft SharePoint 2010
• Creating a Reports Library in Microsoft SharePoint 2010
• Installing SQL Server Reporting Services Add-in for SharePoint 2010 Technologies
• Configuring Reporting Services Integration

Requirements

The following components must be installed before you can install SQL Server 
Reporting Services 2008 R2 to use with Microsoft Dynamics GP.

If you are using Reporting Services 2008 R2, you can use either the SQL Server 2008 
database engine, SQL Server 2008 R2 database engine, or the SQL Server 2005 database 
engine for Microsoft Dynamics GP.

Microsoft Dynamics GP CRM requirements

You must be using SQL Server 2008 R2 Reporting Services and Microsoft Dynamics 
CRM 2011 or later to deploy SQL Server Reporting Services reports and metrics that 
includes CRM data. Microsoft Dynamics CRM supports only the native mode of 
deployment of SQL Server Reporting Services.

You must install the Microsoft Dynamics CRM Reporting Extensions on the 
Microsoft Dynamics GP report server to render reports. Before you render a SQL 

Item Requirements

Operating system
32-bit and 64-bit supported

Server
Windows Server 2003 with latest service pack
Windows Server 2008 with latest service pack
Windows Server 2008 R2 with latest service pack

Client
Windows Vista with latest service pack
Windows 7 with latest service pack

Database Microsoft SQL Server 2008 with service pack 1 or later
Microsoft SQL Server 2008 R2

SharePoint Windows SharePoint Services 3.0 or later
Microsoft Office SharePoint Server, Enterprise Edition
Microsoft SharePoint Foundation 2010
Microsoft SharePoint Server 2010

 Web browser Internet Explorer 9
Internet Explorer 8
Internet Explorer 7

Microsoft Dynamics GP Microsoft Dynamics GP 2010 R2 or later
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Server Reporting Services report with CRM data, be sure to start the Microsoft 
Dynamics CRM application to initialize data.

Configuring Web Server (IIS) role for Reporting 
Services 2008 R2

Internet Information Services (IIS) must be installed before Reporting Services 
because a Web site and a Web services are created during the Reporting Services 
installation. IIS is a set of Internet-based services for servers using Microsoft 
Windows. IIS hosts Web sites and Web services.

To configure IIS for Windows Server 2003:
1. Open the Add or Remove Programs control panel.

(Start > Control Panel > Add or Remove Programs)

2. Click Add/Remove Windows Components to open the Windows Components 
Wizard. 

3. Mark Applications Server in the Components list and click the Details button.

4. Mark the following Application Server subcomponents.

• ASP.Net
• Enable network COM + access
• Enable network DTC access
• Internet Information Services (IIS)

5. Select Internet Information Services (IIS) and click the Details button.

6. Mark the following Internet Information Services (IIS) subcomponents.

• Common Files
• Internet Information Services Manager

7. Click OK. 

The additional components are installed. You may be asked to insert the 
Windows Server 2003 product CD to continue the installation.

To configure Web Server (IIS) for Windows Server 2008:
1. Open the Server Manager.

(Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. 

5. In the message dialog, click Add Required Features to add features required for 
the Web Server (IIS) role.

6. Click Next to continue.
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7. Review the information about the Web Server (IIS) role. Click Next to continue.

8. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

9. Click Next.

10. Review the installation messages, and then click Install.

11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are 
displayed.

To configure Web Server (IIS) for Windows Server 2008 
R2:
1. Open the Server Manager.

(Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. 

5. In the message dialog, click Add Required Features to add features required for 
the Web Server (IIS) role.

6. Click Next to continue.

Role Service component Required subcomponent

Common HTTP Features Static Content
Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Application Development ASP.Net
.NET Extensibility
ISAPI Extensions
ISAPI Filters
Server Side includes

Health and Diagnostics HTTP Logging
Request Monitor

Security Basic Authorization
Windows Authorization
Digest Authorization
Request Filtering

Performance Static Content Compression
IIS Management Console
IIS 6 Management Compatibility

ISS 6 Metabase Compatibility
ISS 6 WMI Compatibility
ISS 6 Scripting Tools
ISS 6 Management Console
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7. Review the information about the Web Server (IIS) role. Click Next to continue.

8. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

9. Click Next.

10. Review the installation messages, and then click Install.

11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are 
displayed.

Installing Reporting Services 2008 R2

You can follow the instructions in this section if you have not yet installed Microsoft 
SQL Server Reporting Services. This procedure assumes that you have already 
installed Microsoft SQL Server 2008 R2, but not Reporting Services. These 
instructions are for installing Reporting Services as a single-server configuration. A 
single-server configuration is where the report server database is installed locally so 
that all server components are on the same computer. For more information about 
configurations, see Chapter 1, “Deployment configurations.”

When running the SQL Server installation program, you must be logged in as a 
member of the local system administrators group. Your SQL Server login account 
must have administrator permissions in SQL Server so you can create logins, roles 
and databases, and assign roles to logins.

Role Service component Required subcomponent

Common HTTP Features Static Content
Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Application Development ASP.Net
.NET Extensibility
ISAPI Extensions
ISAPI Filters
Server Side includes

Health and Diagnostics HTTP Logging
Request Monitor

Security Basic Authorization
Windows Authorization
Digest Authorization
Request Filtering

Performance Static Content Compression

Management Tools IIS Management Console
IIS 6 Management Compatibility

ISS 6 Metabase Compatibility
ISS 6 WMI Compatibility
ISS 6 Scripting Tools
ISS 6 Management Console
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The SQL Server that hosts your Microsoft Dynamics GP data must be using mixed-mode 
authentication. (Mixed-mode authentication allows you to use either Windows 
Authentication or SQL Authentication to access the SQL Server.)

To install Reporting Services 2008 R2:
1. Insert the SQL Server 2008 R2 media. The main SQL Server installation screen 

should appear. If you do not see this screen, browse the media and double-click 
the setup.exe file.

2. Click Yes to make changes to your computer if you are using User Account 
Control. 

3. In the SQL Server Installation Center, click Installation.

4. Click New installation or add features to an existing installation.

5. In the Setup Support Rules window, click OK.

6. In the Setup Support Files window, click Install.

7. Your computer is scanned for conditions that may cause possible installation 
problems. To proceed with the installation, click Next. 

8. In the Installation Type window, select Add features to an existing instance of 
SQL Server 2008 R2 and click Next.

9. In the Feature Selection window, select Reporting Services and any other 
feature you want to install. Click Next.

10. In the Installation Rules window, click Next.

11. In the Disk Space Requirements window, click Next.

12. In the Server Configuration window, enter the Account Name. Click Next.

13. In the Reporting Services Configuration window, click Next.

You will have to configure the report server using the Reporting Services 
Configuration Manager after installing Reporting Services.

14. In the Error Reporting window, click Next.

15. In the Installation Configuration Rules window, click Next.

16. In the Ready to Install window, click Install. 

17. The Installation Progress window appears, allowing you to view the status of 
the installation. Click Next after the installation is completed.

18. In the Complete window, click Close to exit the installation wizard.

19. Restart the computer if you are instructed to do so.
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Configuring Reporting Services 2008 R2

After installing Reporting Services, use the Report Server Configuration Manager to 
configure and start Reporting Services. The Report Server Configuration Manager 
has a number of pages that you can use to configure Reporting Services.

To configure Reporting Services 2008 R2:
1. Start Reporting Services Configuration Manager.

(Start > All Programs > Microsoft SQL Server 2008 R2 > Configuration Tools 
> Reporting Services Configuration Manager)

2. Click Yes to make changes to your computer if you are using User Account 
Control. 

3. Enter the name of a server and select an instance to connect to a report server 
instance. Click Connect.

If you installed Reporting Services on a Web server where SQL Server isn’t installed, 
connect to the reporting server and not the SQL server.

4. If Reporting Services isn’t running, click the Start button in the Report Server 
Status page. The Report Server Status page displays status information about 
the instance that you’ve selected.

5. In the navigation pane, click Service Account to open the page. Be sure that the 
Use the built-in account option is selected.

6. In the navigation pane, click Web Service URL to open the Web Service URL 
page. This page allows you to view and change the name of the virtual 
directory used by the Reporting Services Web service. 

7. Click Apply to create a new virtual directory.

8. In the navigation pane, click Database to open the Report Server Database 
page. 

9. Click Change Database.

10. Select to create a new report server database, and click Next.

11. Select Authentication type and specify the user name and password, if 
necessary. Click Next.

12. Specify the database name and specify the mode. Click Next.

13. Select Authentication type and specify the user name and password for your 
credentials, if necessary. Click Next.

14. Verify the database information. Click Next.

15. After the database is configured, click Finish.

16. If you selected Native mode for your report server database, click Report 
Manager URL to open the Report Manager URL page in the navigation pane. 
Click Apply.
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17. Click Exit.

Starting Report Manager 

Report Manager is installed during setup on the same computer as the report server. 
If you selected Native mode for your report server database, you should verify that 
you can connect to the Report Manager.

To start Report Manager:
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By 
default, the URL is http://<ComputerName>/Reports.

Starting Report Server 

If you selected the SharePoint Integrated mode for your report server database, you 
should verify that you can connect to the Report Server.

To start Report Server:
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By 
default, the URL is http://<ComputerName>/ReportServer.

Creating a Reports site in Microsoft SharePoint 2010

If you selected the SharePoint Integrated mode for your report server database, you 
can store reports in a Microsoft SharePoint 2010 reports library. If you don’t have a 
site in Microsoft SharePoint that serves as a central location to manage Reporting 
Services reports, create a Reports site.

If you are using Business Portal 5.1 R2 for Microsoft Dynamics GP, you can use the 
GP Reports Center for your central location.

To create a Reports site in Microsoft SharePoint 2010
1. Type http://<ServerName> in the address field of Internet Explorer. 

2. Click the Site Actions, and then click New site.

3. In the New SharePoint Site page, enter a title and description of the site.

4. Enter the URL name. For example, http://<ServerName>/Reports.

5. Select a template.

6. Choose any other option you want, and then click Create.

Creating a Reports Library in Microsoft SharePoint 
2010

After creating a Reports site in Microsoft SharePoint, you need to create a reports 
library. A reports library is a location on the Reports site where you can store your 
Reporting Services reports.
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If you are using Business Portal 5.1 R2 for Microsoft Dynamics GP, you can create 
the reports library on the GP Reports Center site.

To create a Reports Library in Microsoft SharePoint 2010
1. Type http://<ServerName>/Reports in the address field of Internet Explorer. 

2. Click the Site Actions menu, and then click New Document Library.

3. In the New page, enter a name and a description.

4. Choose any other option you want, and then click Create.

5. In the Library Tools group, click Library settings.

6. Under General Settings in the Document Library Settings page, click Advanced 
settings.

7. In the Advanced settings page, select to allow management of content type.

8. Select Open in the client application as the default open behavior for browser-
enabled documents.

9. Click OK.

10. Under Content types in the Document Library Settings page, click Document.

11. Under Settings in Document page, click Name and description.

12. In the Settings page, change the name to Reports.

13. Click OK.

Installing SQL Server Reporting Services Add-in for 
SharePoint 2010 Technologies

The SQL Server 2008 R2 Reporting Services Add-in for Microsoft SharePoint 
Technologies 2010 allows you to integrate your reporting environment with 
Microsoft SharePoint. Once you install the add-in and configure your servers for 
integration, you can publish Reporting Services reports to a reports library and then 
view and manage the reports from a SharePoint site.

Installing the SQL Server 2008 R2 Reporting Services Add-in will activate the report 
server integration feature for all existing site collections and will automatically 
active for new site collections.

The SQL Server Reporting Services SharePoint 2010 Add-in is installed as a 
prerequisite for SharePoint Foundation and SharePoint Server if Reporting Services 
is already installed. If you install Reporting Services 2008 R2 after installing 
SharePoint, you can use the Microsoft SharePoint 2010 Products Preparation Tool to 
install the add-in or you can download the add-in from http://
www.microsoft.com/downloads.
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To install the SQL Server Reporting Services Add-in for 
SharePoint 2010 Technologies:
1. Download the SQL Server Reporting Services Add-in for SharePoint 

Technologies from http://www.microsoft.com/downloads.

2. In the welcome window, click Next.

3. Accept the license agreement.

4. Enter registration information and click Next.

5. Click Install.

6. After the add-in is installed, click Finish.

Configuring Reporting Services Integration

You must specify integration settings that determine the connection between 
SharePoint and a report server. The settings that you specify are stored in the 
configuration database. You must be an administrator on the SharePoint farm to 
configure report server integration. You also must have a target report server that is 
already connected to a report server database that was created for SharePoint 
integrated.

If you don’t have the SQL Server Reporting Services SharePoint 2010 Add-in 
installed, the configuration pages and general integration are not available.

To configure Reporting Services Integration 
1. Open SharePoint Central Administration. 

(Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central 
Administration)

2. Click General Application Settings.

3. Under the Reporting Services heading, click Reporting Services Integration. 

4. Enter the Report Server Web Service URL. For example, http://<ServerName> 
/ReportServer).

5. Select Windows Authentication as the authentication mode.

6. Enter your credentials and click OK.
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Chapter 6: Installing Reporting Services 2012
Use the information in this chapter to install and configure Reporting Services 2012. 
This chapter contains the following sections:

• Requirements
• Microsoft Dynamics GP CRM requirements
• Configuring Web Server (IIS) role for Reporting Services 2012
• Installing Reporting Services 2012
• Configuring Reporting Services 2012 in Native mode
• Starting Report Manager
• Installing the Reporting Services SharePoint service
• Starting the Reporting Services SharePoint service
• Creating a Reporting Services service application
• Creating a Reports site in Microsoft SharePoint 2010
• Creating a Reports Library in Microsoft SharePoint 2010
• Configuring Reporting Services Integration
• Activating the Claims to Windows Token Service

Requirements

The following components must be installed before you can install SQL Server 
Reporting Services 2012 to use with Microsoft Dynamics GP.

If you are using Reporting Services 2012, you can use either the SQL Server 2008 database 
engine, SQL Server 2008 R2 database engine, or the SQL Server 2012 database engine for 
Microsoft Dynamics GP.

Microsoft Dynamics GP CRM requirements

You must be using SQL Server 2012 Reporting Services and Microsoft Dynamics 
CRM 2011 or later to deploy SQL Server Reporting Services reports and metrics that 
includes CRM data. Microsoft Dynamics CRM supports only the native mode of 
deployment of SQL Server Reporting Services.

Item Requirements

Operating system
32-bit and 64-bit supported

Server
Windows Server 2008 with latest service pack
Windows Server 2008 R2 with latest service pack

Client
Windows Vista with latest service pack
Windows 7 with latest service pack

Database Microsoft SQL Server 2008 with service pack 1 or later
Microsoft SQL Server 2008 R2 
Microsoft SQL Server 2012

SharePoint Microsoft SharePoint Foundation 2010 with service pack 1
Microsoft SharePoint Server 2010 with service pack 1

 Web browser Internet Explorer 9
Internet Explorer 8
Internet Explorer 7

Microsoft Dynamics GP Microsoft Dynamics GP 2010 R2 or later
SQL Server 2012 is compatible with Microsoft Dynamics GP 
2010 11.00.1914 or later.
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You must install the Microsoft Dynamics CRM Reporting Extensions on the 
Microsoft Dynamics GP report server to render reports. Before you render a SQL 
Server Reporting Services report with CRM data, be sure to start the Microsoft 
Dynamics CRM application to initialize data.

Configuring Web Server (IIS) role for Reporting 
Services 2012

Internet Information Services (IIS) must be installed before Reporting Services 
because a Web site and a Web services are created during the Reporting Services 
installation. IIS is a set of Internet-based services for servers using Microsoft 
Windows. IIS hosts Web sites and Web services.

To configure Web Server (IIS) for Windows Server 2008:
1. Open the Server Manager.

(Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. 

5. In the message dialog, click Add Required Features to add features required for 
the Web Server (IIS) role.

6. Click Next to continue.

7. Review the information about the Web Server (IIS) role. Click Next to continue.

8. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

Role Service component Required subcomponent

Common HTTP Features Static Content
Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Application Development ASP.Net
.NET Extensibility
ISAPI Extensions
ISAPI Filters
Server Side includes

Health and Diagnostics HTTP Logging
Request Monitor

Security Basic Authorization
Windows Authorization
Digest Authorization
Request Filtering
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9. Click Next.

10. Review the installation messages, and then click Install.

11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are 
displayed.

To configure Web Server (IIS) for Windows Server 2008 
R2:
1. Open the Server Manager.

(Start > Administrative Tools > Server Manager)

2. Select the Roles node in the Server Manager. The currently installed roles are 
displayed.

3. In the Action menu, choose Add Roles. The Add Roles Wizard appears. Click 
Next to continue.

4. In the list of available roles, select the Web Server (IIS) role. 

5. In the message dialog, click Add Required Features to add features required for 
the Web Server (IIS) role.

6. Click Next to continue.

7. Review the information about the Web Server (IIS) role. Click Next to continue.

8. In the Select Role Services window, select the following subcomponents for the 
Web Server role service.

Performance Static Content Compression
IIS Management Console
IIS 6 Management Compatibility

ISS 6 Metabase Compatibility
ISS 6 WMI Compatibility
ISS 6 Scripting Tools
ISS 6 Management Console

Role Service component Required subcomponent

Common HTTP Features Static Content
Default Document
Directory Browsing
HTTP Errors
HTTP Redirection

Application Development ASP.Net
.NET Extensibility
ISAPI Extensions
ISAPI Filters
Server Side includes

Health and Diagnostics HTTP Logging
Request Monitor

Role Service component Required subcomponent
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9. Click Next.

10. Review the installation messages, and then click Install.

11. After you have viewed the installation results, click Close.

12. Select the Features node in the Server Manager. The currently installed roles are 
displayed.

Installing Reporting Services 2012

You can follow the instructions in this section if you have not yet installed Microsoft 
SQL Server Reporting Services. This procedure assumes that you have already 
installed Microsoft SQL Server 2012, but not Reporting Services. These instructions 
are for installing Reporting Services as a single-server configuration. A single-server 
configuration is where the report server database is installed locally so that all 
server components are on the same computer. For more information about 
configurations, see Chapter 1, “Deployment configurations.”

When running the SQL Server installation program, you must be logged in as a 
member of the local system administrators group. Your SQL Server login account 
must have administrator permissions in SQL Server so you can create logins, roles 
and databases, and assign roles to logins.

The SQL Server that hosts your Microsoft Dynamics GP data must be using mixed-mode 
authentication. (Mixed-mode authentication allows you to use either Windows 
Authentication or SQL Authentication to access the SQL Server.)

To install Reporting Services 2012:
1. Insert the SQL Server 2012 media. The main SQL Server installation screen 

should appear. If you do not see this screen, browse the media and double-click 
the setup.exe file.

2. Click Yes to make changes to your computer if you are using User Account 
Control. 

3. In the SQL Server Installation Center, click Installation.

4. Click New SQL Server stand-alone installation or add features to an existing 
installation.

5. In the Setup Support Rules window, click OK.

Security Basic Authorization
Windows Authorization
Digest Authorization
Request Filtering

Performance Static Content Compression

Management Tools IIS Management Console
IIS 6 Management Compatibility

ISS 6 Metabase Compatibility
ISS 6 WMI Compatibility
ISS 6 Scripting Tools
ISS 6 Management Console

Role Service component Required subcomponent
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6. In the Product Updates window, click Next.

7. Your computer is scanned for conditions that may cause possible installation 
problems. To proceed with the installation, click Next. 

8. In the Installation Type window, select Add features to an existing instance of 
SQL Server 2012 and click Next.

9. In the Feature Selection window, select Reporting Services – Native or 
Reporting Services – SharePoint and any other feature you want to install. Click 
Next.

Be sure to select Reporting Services Add-in for SharePoint Products if you are 
installing on the server where SharePoint is running. 

10. In the Installation Rules window, click Next.

11. In the Disk Space Requirements window, click Next.

12. In the Server Configuration window, specify the service account for SQL Server 
Reporting Services and click Next.

13. In the Reporting Services Configuration window, click Next.

If you are using Native mode, you will have to configure the report server using 
the Reporting Services Configuration Manager after installing Reporting 
Services.

If you are using SharePoint Integrated mode, you will have to use the 
SharePoint Central Administration to complete the configuration. You’ll also 
verify the SQL Server Reporting Services service is started and create at least 
one SQL Server Reporting Services service application.

14. In the Error Reporting window, click Next.

15. In the Installation Configuration Rules window, click Next.

16. In the Ready to Install window, click Install. 

17. The Installation Progress window appears, allowing you to view the status of 
the installation. Click Next after the installation is completed.

18. In the Complete window, click Close to exit the installation wizard.

19. Restart the computer if you are instructed to do so.

Configuring Reporting Services 2012 in Native mode

After installing Reporting Services, use the Report Server Configuration Manager to 
configure and start Reporting Services. The Report Server Configuration Manager 
has a number of pages that you can use to configure Reporting Services.
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To configure Reporting Services 2012 in Native mode:
1. Start Reporting Services Configuration Manager.

(Start > All Programs > Microsoft SQL Server 2012 > Configuration Tools > 
Reporting Services Configuration Manager)

2. Click Yes to make changes to your computer if you are using User Account 
Control. 

3. Enter the name of a server and select an instance to connect to a report server 
instance. Click Connect.

If you installed Reporting Services on a Web server where SQL Server isn’t installed, 
connect to the reporting server and not the SQL server.

4. If Reporting Services isn’t running, click the Start button in the Report Server 
Status page. The Report Server Status page displays status information about 
the instance that you’ve selected.

5. In the navigation pane, click Service Account to open the page. Be sure that the 
Use the built-in account option is selected.

6. In the navigation pane, click Web Service URL to open the Web Service URL 
page. This page allows you to view and change the name of the virtual 
directory used by the Reporting Services Web service. 

7. Click Apply to create a new virtual directory.

8. In the navigation pane, click Database to open the Report Server Database 
page. 

9. Click Change Database.

10. Select to create a new report server database, and click Next.

11. Select Authentication type and specify the user name and password, if 
necessary. Click Next.

12. Specify the database name and specify the mode. Click Next.

13. Select Authentication type and specify the user name and password for your 
credentials, if necessary. Click Next.

14. Verify the database information. Click Next.

15. After the database is configured, click Finish.

16. Click Report Manager URL to open the Report Manager URL page in the 
navigation pane. Click Apply.

17. Click Exit.
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Starting Report Manager 

Report Manager is installed during setup on the same computer as the report server. 
If you selected Native mode for your report server database, you should verify that 
you can connect to the Report Manager.

To start Report Manager:
1. Open Microsoft Internet Explorer.

2. In the address bar of the Web browser, type the Report Manager URL. By 
default, the URL is http://<ComputerName>/Reports.

Installing the Reporting Services SharePoint service

The SharePoint Integrated mode for Reporting Services uses a SharePoint service. If 
the SharePoint farm is new, the necessary files were installed as part of the 
Reporting Services using the SQL Server installation wizard. You still need register 
service into the SharePoint farm. 

You don’t need to complete the following steps for an existing SharePoint farm. The 
Reporting Services SharePoint service was installed and started when you used the 
SQL Server installation wizard to install Reporting Services.

To install the Reporting Services SharePoint service:
1. Open the Windows PowerShell®. 

Start > Microsoft SharePoint 2010 Products > right-click SharePoint 2010 
Management Shell > click Run as administrator

2. Run the following command to install the SharePoint service. 

If the command was successful, a new line appears in the management shell.

3. Run the following command to install the service proxy.

Starting the Reporting Services SharePoint service

After installing the Reporting Services SharePoint service, you must start or verify 
that the service is running.

To start Reporting Services SharePoint service:
1. Open SharePoint Central Administration. 

Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central 
Administration

2. Under the System Settings heading, click Manage services on server. 

3. Be sure that the SQL Server Reporting Services Service is started. If the service 
isn’t started, click Start in the Action column.

Install-SPRSService

Install-SPRSServiceProxy
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If the SQL Server Reporting Services Service is not in the list, verify you have 
installed the service. See Installing the Reporting Services SharePoint service on 
page 49.

Creating a Reporting Services service application

The SharePoint Integrated mode for Reporting Services uses a SharePoint service 
and one or more service applications. Creating a service application makes the 
service available and generates the service application database. One service 
application is sufficient for most deployment configurations, but you can create 
multiple Reporting Services service applications.

To create Reporting Services service application:
1. Open SharePoint Central Administration. 

Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central 
Administration

2. Under the Application Management heading, click Manage service 
applications.

3. In the SharePoint ribbon, click New.

4. In the New menu, select SQL Server Reporting Services Service Application.

If the SQL Server Reporting Services Service Application is not in the list, verify 
you have installed the service. See Installing the Reporting Services SharePoint 
service.

5. In the Create SQL Server Reporting Services Service Application page, enter a 
name for the application. 

6. In Application Pool section, create a new application pool for the application. 

7. Select or create a managed account for the application pool. Be sure to specify a 
domain user account. 

A domain user account allows you to use SharePoint's managed account 
feature, which allows you to update passwords and account information in one 
place. 

8. In the Database server field, accept the current server or enter a different SQL 
Server. 

9. In Database Name field, the default value is ReportingService_<guid>, which 
is a unique database name. If you enter a new value, we recommend that you 
use a unique database for each service application.

10. In Database Authentication option, the default value is Windows 
Authentication. If you choose SQL Authentication, refer to the SharePoint 
administrator guide for best practices about this authentication type in a 
SharePoint deployment.

11. In the Web Application Association section, select the web application to be 
used for access by the current Reporting Services Service Application. You can 
associate one Reporting Services service application to one web application.
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12. Click OK.

The service application creation process may take several minutes to complete. 

Creating a Reports site in Microsoft SharePoint 2010

If you selected the SharePoint Integrated mode for your report server database, you 
can store reports in a Microsoft SharePoint 2010 reports library. If you don’t have a 
site in Microsoft SharePoint that serves as a central location to manage Reporting 
Services reports, create a Reports site.

If you are using Business Portal 5.1 R2 for Microsoft Dynamics GP, you can use the 
GP Reports Center for your central location.

To create a Reports site in Microsoft SharePoint 2010
1. Type http://<ServerName> in the address field of Internet Explorer. 

2. Click the Site Actions, and then click New site.

3. In the New SharePoint Site page, enter a title and description of the site.

4. Enter the URL name. For example, http://<ServerName>/Reports.

5. Select a template.

6. Choose any other option you want, and then click Create.

Creating a Reports Library in Microsoft SharePoint 
2010

After creating a Reports site in Microsoft SharePoint, you need to create a reports 
library. A reports library is a location on the Reports site where you can store your 
Reporting Services reports.

If you are using Business Portal 5.1 R2 for Microsoft Dynamics GP, you can create 
the reports library on the GP Reports Center site.

To create a Reports Library in Microsoft SharePoint 2010
1. Type http://<ServerName>/Reports in the address field of Internet Explorer. 

2. Click the Site Actions menu, and then click New Document Library.

3. In the New page, enter a name and a description.

4. Choose any other option you want, and then click Create.

5. In the Library Tools group, click Library settings.

6. Under General Settings in the Document Library Settings page, click Advanced 
settings.

7. In the Advanced settings page, select to allow management of content type.

8. Select Open in the client application as the default open behavior for browser-
enabled documents.
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9. Click OK.

10. Under Content types in the Document Library Settings page, click Document.

11. Under Settings in Document page, click Name and description.

12. In the Settings page, change the name to Reports.

13. Click OK.

Configuring Reporting Services Integration

You must specify integration settings that determine the connection between 
SharePoint and a report server. The settings that you specify are stored in the 
configuration database. You must be an administrator on the SharePoint farm to 
configure report server integration. You also must have a target report server that is 
already connected to a report server database that was created for SharePoint 
integrated.

If you don’t have the SQL Server Reporting Services SharePoint 2010 Add-in 
installed, the configuration pages and general integration are not available.

To configure Reporting Services Integration:
1. Open SharePoint Central Administration. 

(Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central 
Administration)

2. Click General Application Settings.

3. Under the Reporting Services heading, click Reporting Services Integration. 

4. Enter the Report Server Web Service URL. For example, http://<ServerName> 
/ReportServer).

5. Select Windows Authentication as the authentication mode.

6. Enter your credentials and click OK.

Activating the Claims to Windows Token Service

Be sure that the Claims to Windows Token Service has been started. 

To activate the Claims to Windows Token Service:
1. Open SharePoint Central Administration. 

(Start > Microsoft SharePoint 2010 Products > SharePoint 2010 Central 
Administration)

2. Under the System Settings heading, click Manage services on server. 

3. Be sure that the Claims to Windows Token Service is started. If the service isn’t 
started, click Start in the Action column.
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Chapter 7: Deploying Reporting Services reports
This chapter explains how to deploy predefined SQL Server Reporting Services 
reports that are included in Microsoft Dynamics GP to a server or Microsoft 
SharePoint site. If you are using SQL Server 2008 Reporting Services or SQL Server 
2008 R2 Reporting Services, you also can deploy charts and key performance 
indicators (KPIs). Once the reports and charts and KPIs are stored on a server or on 
a Microsoft SharePoint library, users can access them without starting Microsoft 
Dynamics GP as long as they have the appropriate security access. 

Before you deploy Reporting Services reports, be sure that Dexterity Shared Components are 
installed on the computer.

This chapter includes the following sections.

• Modify the Report Server web.config file
• Using the Reporting Tools Setup window
• Deploying SQL Server Reporting Services reports in Native mode
• Deploying SQL Server Reporting Services reports in SharePoint Integrated mode

Modify the Report Server web.config file

To deploy the SQL Server Reporting Services reports, you must modify the Report 
Server web.config file for the timeout execution and the maximum request length. If 
you don’t update the Report Server web.config file for the timeout execution, you 
might receive an error that states that “the operation has timed out.” If you don’t 
update the Report Server web.config file for the maximum request length, you will 
receive an error that the deployment has exceeded the maximum request length 
allowed by the target server.

You must be an administrator to modify the Report Server web.config file.

To modify the Report Server Web.config file:
1. Create a backup copy of the web.config file located in the ReportServer folder. 

(The ReportServer folder is located in C:\Program Files\Microsoft SQL 
Server\MSSQLSERVER\Reporting Services\ReportServer where Reporting 
Services is installed.)

2. Open the Report Server web.config file using a text editor, such as Notepad.

3. Search for <httpRuntime executionTimeout="9000" />.

4. In that line, change executionTimeout=”9000” to executionTimeout=”19000” 
and add the value maxRequestLength="20960".

(<httpRuntime executionTimeout="19000" maxRequestLength="20960"/>

5. Save and close the Report Server web.config file.

Using the Reporting Tools Setup window

Use the Reporting Tools Setup window to deploy the predefined SQL Server 
Reporting Services reports that are available in Microsoft Dynamics GP to the 
Report Server or to a Microsoft SharePoint library. You also can use the Reporting 
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Tools Setup window to redeploy reports or deploy reports to a different location. 
Deploying reports to a new location does not deploy reports from the existing 
location to the new location. If you are using more than one instance of Microsoft 
Dynamics GP, you should only deploy reports to the report server for one instance 
at a time.

Deployment Options The Deployment Options list has a tree view that 
displays the deployment status of each company and of each report type. You can 
select to deploy reports by company and by report type. 

There are three levels in the tree view. You can collapse and expand the entire tree or 
just portions of it. A check mark next to a level means that the reports are available 
to deploy. All items that are not fully deployed will automatically be marked. 

Redeploy all reports for selected companies You can mark to redeploy 
reports for the companies you selected. When you choose the Deploy Reports 
button, previously deployed reports for the selected companies are overwritten.

Print status of all companies You can mark this option to print the SQL 
Server Reporting Services Deployment Status report. The report displays 
information for all companies. You can choose File > Print to print the report with 
only information for the company you are currently logged in to. 

Refresh button  Choose this button to validate and save the report location 
information. The Deployment Options tree view is updated based on the report 
location information.

Deploying SQL Server Reporting Services reports in 
Native mode

Use the Reporting Tools Setup window to deploy the predefined SQL Server 
Reporting Services reports that are available in Microsoft Dynamics GP to the 
Report Server. You also can use the Reporting Tools Setup window to redeploy 
reports or deploy reports to a different location. If you are using Reporting Services 
2008 or Reporting Services 2008 R2, you also can deploy charts and KPIs. If you are 
using more than one instance of Microsoft Dynamics GP, you should only deploy 
reports to the report server for one instance at a time.

You must be using Reporting Services 2005 Service Pack 2 or later, Reporting Services 
2008, or Reporting Services 2008 R2 to use the predefined SQL Server Reporting Services 
reports in Microsoft Dynamics GP.
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To deploy SQL Server Reporting Services reports in Native 
mode:
1. Open the Reporting Tools Setup window.

(Microsoft Dynamics GP menu > Tools > Setup > System > Reporting Tools 
Setup)

2. On the SQL Reporting Services tab, select the Native mode.

Microsoft Dynamics CRM 2011 supports only the native mode of deployment of 
Microsoft SQL Server Reporting Services.

3. Enter the following locations for the Native mode. Be sure that your location 
doesn’t end with a slash.

Native mode location example:

4. If you are using Microsoft Dynamics CRM 2011, enter the URL for the CRM 
service, the name of the organization, and specify credentials for the data 
source.

We recommend that you use Windows Authentication (Integrated Security). If 
you select to be prompted for credentials, you must mark the Use as Windows 
credentials when connecting to the data source option on the data source 
deployed.

You must be using SQL Server 2008 R2 Reporting Services and Microsoft Dynamics 
CRM 2011 or later to deploy SQL Server Reporting Services reports and metrics that 

Location Example

Report Server URL http://<servername>/ReportServer

Report Manager URL http://<servername>/Reports
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includes CRM data. Microsoft Dynamics CRM supports only the native mode of 
deployment of SQL Server Reporting Services.

5. To verify your locations, choose the Refresh button in the upper right hand 
corner of the Deployment Options tree view.

6. In the Deployment Options tree view, all items that are not fully deployed are 
automatically marked. 

To exclude an item, unmark the check box. For example, if you don’t want to 
deploy Reporting Services reports in Fabrikam, Inc., expand the Company level 
in the tree view and unmark SRS Reports.

7. Choose Deploy Reports to deploy reports. 

The Business Intelligence Deployment Progress window appears. This window 
displays the report deployment progress.

If you don’t have the appropriate permissions to deploy reports, a window 
opens where you can enter a domain\user name and the password you use to 
log in to Microsoft Windows. 

8. After the reports are deployed, choose Print Status Report to view the 
deployment status of reports.

Deploying SQL Server Reporting Services reports in 
SharePoint Integrated mode

Use the Reporting Tools Setup window to deploy the predefined SQL Server 
Reporting Services reports that are available in Microsoft Dynamics GP to a 
Microsoft SharePoint library. You also can use the Reporting Tools Setup window to 
redeploy reports or deploy reports to a different location. If you are using Reporting 
Services 2008 or Reporting Services 2008 R2, you also can deploy charts and KPIs. If 
you are using more than one instance of Microsoft Dynamics GP, you should only 
deploy reports to the report server for one instance at a time.

You must be using Reporting Services 2008, or Reporting Services 2008 R2 to use the 
predefined SQL Server Reporting Services reports in Microsoft Dynamics GP.
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To deploy SQL Server Reporting Services reports in 
SharePoint Integrated mode:
1. Open the Reporting Tools Setup window.

(Microsoft Dynamics GP menu > Tools > Setup > System > Reporting Tools 
Setup)

2. On the SQL Reporting Services tab, select the SharePoint Integrated mode.

3. Enter the locations for the SharePoint site and report library. Be sure that your 
location doesn’t end with a slash.

SharePoint Integrated mode location example:

Microsoft Dynamics CRM 2011 supports only the native mode of deployment of 
Microsoft SQL Server Reporting Services.

4. To verify your locations, choose the Refresh button in the upper right hand 
corner of the Deployment Options tree view.

5. In the Deployment Options tree view, all items that are not fully deployed are 
automatically marked. 

To exclude an item, unmark the check box. For example, if you don’t want to 
deploy Reporting Services reports in Fabrikam, Inc., expand the Company level 
in the tree view and unmark SRS Reports.

SharePoint Integrated

Location Example

SharePoint Site http://<servername>/SharePoint site

Report Library ReportsLibrary
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6. Choose Deploy Reports to deploy reports. 

The Business Intelligence Deployment Progress window appears. This window 
displays the report deployment progress.

If you don’t have the appropriate permissions to deploy reports, a window 
opens where you can enter a domain\user name and the password you use to 
log in to Microsoft Windows. 

7. After the reports are deployed, choose Print Status Report to view the 
deployment status of reports.
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Chapter 8: Reporting Services Security Setup
After the installation and configuration of Reporting Services and deploying the 
Microsoft Dynamics GP SQL Server Reporting Services reports, the only 
individuals who will be able to access or view the reports within the Report 
Manager are those users who are members of the Web server’s local administrator 
group and local administrators on SQL Server. The Web site administrator has to 
implement and grant access to the Reporting Services Web site and database objects 
required to print reports.

If you deployed reports to Microsoft SharePoint, you can use Microsoft SharePoint 
security to grant access to report server items that you access from SharePoint sites 
and libraries. SharePoint security is similar to how role assignments are used in a 
native mode report server deployment, where a role assignment maps a user or 
group account to a set of tasks related to an item. 

This chapter has the following sections.

• Designing Reporting Services security
• Granting access to the Reporting Services Web site
• Database security setup
• SharePoint Security for Reporting Services
• Creating a permission level in SharePoint 2010
• Creating a new group in SharePoint 2010
• Granting a group access to a site in SharePoint 2010
• Adding users to a group in SharePoint 2010

Designing Reporting Services security

Before you implementing security for Reporting Services, determine your security 
requirements. You should identify the following information.

• Which users have access to which companies 
• Which users should have access to which series of reports
• Which users should or should not have access to an individual report

The default security setup is to use your Windows credentials through to the 
database level. The process is the same as granting access to files and folders at the 
Windows level. You’ll use groups or individual domain users when granting access. 
For the domain users or groups to have access and see the reports within the Report 
Manager, they must be granted permission at the Web site.

Granting access to the Reporting Services Web site

To get the domain users to view and have access the reports within the Report 
Manager, they must be granted permission to the Web site using SQL Server 
Management Studio or the Report Manager.

To grant access from the Report Manager using Reporting 
Services 2005:
1. Open Report Manager by entering the Report Manager URL in the address bar 

of the Web browser. The default URL is http://<ComputerName>/reports.

2. Click Site Settings on the home page.
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If Site Settings is not available, you do not have permission to access site settings.

3. In the Security section, click Configure site-wide security.

4. To enable access for a new user or group, click New Role Assignment.

5. Enter the name of the user or group account.

6. Select one or more system role definitions to use with this assignment.

7. Click OK.

8. Click Home to open the Home page.

9. Click the Properties tab.

10. Click New Role Assignment to open the New Role Assignment page.

11. Enter the name of the user or group account.

12. Select select one or more roles until the combined set of tasks describe the 
actions that the user should be allowed to perform. To view the set of tasks that 
each role supports, click the role name.

To grant access from the Report Manager using Reporting 
Services 2008:
1. Open Report Manager by entering the Report Manager URL in the address bar 

of the Web browser. The default URL is http://<ComputerName>/reports.

2. Click Site Settings on the home page.

If Site Settings is not available, you do not have permission to access site settings.

3. In the Site Settings page, click Security.

4. To enable access for a new user or group, click New Role Assignment.

5. Enter the name of the user or group account.

6. Select one or more system role definitions to use with this assignment.

7. Click OK.

8. Click Home to open the Home page.

9. Click the Properties tab.

10. Click New Role Assignment to open the New Role Assignment page.

11. Enter the name of the user or group account.

12. Select select one or more roles until the combined set of tasks describe the 
actions that the user should be allowed to perform. To view the set of tasks that 
each role supports, click the role name.
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To grant access from the Report Manager using Reporting 
Services 2008 R2 or 2012:
1. Open Report Manager by entering the Report Manager URL in the address bar 

of the Web browser. The default URL is http://<ComputerName>/reports.

2. Click Site Settings on the home page.

If Site Settings is not available, you do not have permission to access site settings.

3. In the Site Settings page, click Security.

4. To enable access for a new user or group, click New Role Assignment.

5. Enter the name of the user or group account.

6. Select one or more system role definitions to use with this assignment.

7. Click OK.

8. Click Home to open the Home page.

9. Click the Folder Settings tab.

10. Click New Role Assignment to open the New Role Assignment page.

11. Enter the name of the user or group account.

12. Select select one or more roles until the combined set of tasks describe the 
actions that the user should be allowed to perform.

To grant access from the SQL Server Management Studio:
1. Open SQL Server Management Studio.

(Start > Programs > Microsoft SQL Server 2005 > SQL Server Management 
Studio)

2. Select Reporting Services as the server type, enter the name of server, and click 
Connect.

3. Right-click the server name, and select Properties.

4. The Server Properties – <Server Name> window opens. Click Permissions. The 
default access is to the local machine’s BUILTIN\Administrators group. 
Members of this group will have access to all reports.

5. Click the Add Group or User button.

6. In the Add Group or User window, enter the name of the group or user to give 
access to, and click OK.

7. The new group or user appears in the Server Properties – <Server Name> 
window. 

8. Mark the appropriate role access to the report server site. 
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If you mark System Administrators, users in the group can enable features and 
set defaults, set site-wide security, create role definitions, and manage jobs.

If you mark System User box, users in the group can execute reports, view 
report server properties, and share report schedules.

9. Click OK.

10. To grant access Report Manager’s Home folder, right-click Home and select 
Properties.

11. The Folder Properties window opens. Click Permissions.

12. Click the Add Group or User button.

13. In the Add Group or User window, enter the name of the group or user, and 
click OK.

14. The new group or user appears in the Folder Properties window. 

15. Mark the appropriate item-level roles that each group or user account can have 
in relation to the item. 

16. Click OK.

Database security setup

You need to grant group or user access to SQL Server and the appropriate databases 
to allow a user to run Report Services reports. Use the following procedure to create 
a new SQL Server login for the group or user and assign the appropriate database 
roles to the login for access to Report Services reports. To review what database 
roles for reports, download MDGP11R2_SRS_Report_Roles.pdf (https://
mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-
f3dd5b30632b). (CustomerSource login required.)

Users might see reports listed in a browser, but they cannot view the data on the reports 
until security access has been granted in SQL Server.

Before creating new SQL Server logins, you should carefully plan the accounts and 
the type of accounts to be created. You need to decide whether or not to add the 
individual Windows accounts or to use local or domain groups for access. You 
should consider access to the Report Services reports and the local folders being 
created on the Web server, as well.

To add Windows domain users or groups in SQL Server:
1. Open SQL Server Management Studio.

(Start > All Programs > Microsoft SQL Server > SQL Server Management 
Studio)

2. Select Database Engine, enter the name of server, and enter authentication 
information. Click Connect.

3. Expand the Security folder.

4. Right-click the Logins folder, and select New Login.

https://mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-f3dd5b30632b 
https://mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-f3dd5b30632b 
https://mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-f3dd5b30632b 
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5. In the Login – New window, enter the user or group that you want to have 
access to the SQL Server. If you don’t know the login name, you can click the 
Search button and look for the name.

6. Click OK.

7. After adding the login, it should be listed under the Logins folder. 

8. To add new login as a user to the appropriate database, right-click the new 
login, and click Properties.

9. Click User Mapping.

10. Under Users mapped to this login, mark Dynamics.

11. Under Database role membership for: Dynamics, mark the rpt_All user 
database role or the rpt_All group database role.

The rpt_All group database role is required for all users to run Reporting Services 
reports.

12. Under Users mapped to this login, mark the company database that the user or 
group should have access to.

13. Under Database role membership for: <company database>, mark the 
appropriate database roles that are required.

To review what database roles for reports, download To review what database 
roles for reports, download MDGP11R2_SRS_Report_Roles.pdf (https://
mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-
f3dd5b30632b). (CustomerSource login required.)

14. Click OK.

SharePoint Security for Reporting Services

You can use Microsoft SharePoint security to grant access to report server items that 
you access from SharePoint sites and libraries. SharePoint security is similar to how 
role assignments are used in a native mode report server deployment, where a role 
assignment maps a user or group account to a set of tasks related to an item. The 
policies of SharePoint security map a user or group account with a permission level.

SharePoint groups and permission levels are defined at the site collection level and 
are inherited from the parent object by default. A SharePoint group is a set of users 
that can be managed together. Permission levels are collections of permissions that 
allow users to perform a set of related tasks. 

If you already assigned permissions to users, those same users will have access to 
report server items and operations immediately after you configure the integration 
settings between SharePoint and a report server. You can use existing permissions to 
upload report definitions and other documents, view reports, create subscriptions, 
and manage items.

If you have not assigned permissions, you can assign user and group accounts to 
predefined SharePoint groups or create new permission levels and groups, or 
modify existing ones to vary server access permissions as the need arise. 

https://mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-f3dd5b30632b 
https://mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-f3dd5b30632b 
https://mbs2.microsoft.com/fileexchange/?fileID=29588511-77d5-4eef-b5e1-f3dd5b30632b 
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Creating a permission level in SharePoint 2010

Permission levels are used globally throughout a site. If you create a new 
permission level, it will be available to other site owners. You may want to create a 
permission level for users who aren’t administrators so they can view reports in the 
document library.

To create a permission level in SharePoint 2010: 
1. Verify that you have one of the following administrative credentials:

• You are a member of the Administrators group for the site collection.
• You are a member of the Owners group for the site.
• You have the Manage Permissions permission.

2. On the Site Settings page, under Users and Permissions, click Site permissions.

3. In the Manage section of the ribbon, click Permission Levels.

4. On the toolbar, click Add a Permission Level.

5. On the Add a Permission Level page, enter a name for the new permission 
level. For example, Read Reports.

6. Enter a description of the new permission level.

7. In the list of permissions, select the check boxes to add permissions to the 
permission level. Be sure to select the following permissions.

8. Click Create.

Creating a new group in SharePoint 2010

A SharePoint group is a set of users that can be managed together. You may want to 
create a group for users who aren’t administrators so they can view reports in the 
document library.

To create a group, you need to have the Manage Permissions level for the site or 
content you are working with. To see if you have Manage Permissions permissions 
level, click the Site Actions menu and look for the Site Permissions option. If you 
don’t have the option, you don’t have the permission to manage permissions.

To create a new group in SharePoint 2010: 
1. On the Site Actions menu, click Site Permissions. 

2. On the Permission Tools tab, click Create Group. 

Type Permissions

List Permission Edit Items 
View Items 
Open Items 

Site Permission View Pages 
Browse User Information 
Use Remote Interfaces 
Open
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3. On the Create Group page, in the Name and About Me Description section, 
specify the name and optionally a description for this security group. 

4. In the Owner section, specify the owner of this security group. 

5. In the Group Settings section, specify who can view and edit the membership of 
this group. 

6. In the Membership Requests section, specify the settings that you want for 
requests to join or leave the group. 

7. Click Create. 

Granting a group access to a site in SharePoint 2010

To grant a group access to a SharePoint, you need to have the Manage Permissions 
level for the site or content you are working with. To see if you have Manage 
Permissions permissions level, click the Site Actions menu and look for the Site 
Permissions option. If you don’t have the option, you don’t have the permission to 
manage permissions.

To grant a group access to a site in SharePoint 2010: 
1. On the Site Actions menu, click Site Permissions. 

2. Click Grant Permissions.

3. In the Grant Permissions window, enter the names of the groups (or users) to 
whom you want to grant access to your site. 

4. If you enter the names of users, you can add them to an existing group. (You can 
grant permissions to individual users directly. However, the cost of maintaining 
a system such as that adds up quickly.)

5. Click OK.

Adding users to a group in SharePoint 2010

To add users to a group, you need to have the Manage Permissions level for the site 
or content you are working with. To see if you have Manage Permissions 
permissions level, click the Site Actions menu and look for the Site Permissions 
option. If you don’t have the option, you don’t have the permission to manage 
permissions.

To add users to a group in SharePoint 2010: 
1. On the Site Actions menu, click Site Permissions. 

2. On the permissions page, click the link for the security group to which you 
want to add users. 

3. On the People and Groups - Group Name page, on the New menu, click Add 
Users. 

4. In the Grant Permissions window, use the browse button to select the users 
that you want to add to this security group. 
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